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1 Overview of Nokia Flexi EDGE BTS site
commissioning

Purpose

This is an overview of how to commission Nokia Flexi EDGE BTS sites
using the Commissioning Wizard in the Nokia Flexi EDGE BTS Manager
software. The purpose of commissioning is to integrate the BTS as a part
of the network.

Commissioning is part of the Implementation phase of the site roll-out
process. It uses outputs from the Radio Network Planning and TRS
Planning phases in the form of Site Configuration Files (SCF), templates
and/or paper instructions that define the parameters required to make the
BTS site operational.

Commissioning is required in order to make a site operational and is a key
component of site acceptance. Commissioning is also required in order to
test the basic functionality of the BTS as a 'stand-alone network element'
to ensure a seamless integration and operation into a live GSM/EDGE
network.

Nokia Flexi EDGE BTS commissioning uses a Site Configuration File
(SCF), which is written in a standard RAML2.1 compliant XML format.

The use of the SCF allows configurations to be fully or partially specified
off-site and to be distributed to commissioning engineers electronically.

You can select one of the following commissioning modes, depending on
how much of the site information has been pre-generated:
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. EasyWizard Template Commissioning

EasyWizard template commissioning is applicable for the majority of
sites, and is a simple, fast and flexible way of commissioning Nokia
Flexi EDGE BTS. This mode requires two SCF template files, which
have been pre-generated offline using the EasyWizard template
generation mode of the Nokia Flexi EDGE BTS Manager
Commissioning Wizard:
. one SCF template file for the hardware configuration, and
. another SCF template file for transmission configuration.

Once the correct templates have been loaded, the commissioner
needs to enter those parameters that are specific to a site.

. EasyWizard Complete SCF Commissioning

EasyWizard Complete SCF Commissioning can be used on any
site. This mode requires that an SCF is created for each site
beforehand. The commissioning engineer only needs to select the
right file and send it to the BTS.

Because the creation of the complete SCF allows the user to edit
any and all commissioning parameters, it is comparable to pre-
commissioning a specific unit off-site in a laboratory without the need
to have any physical unit present.

It is not possible to change any of the commissioning information
on-site when EasyWizard Complete SCF Commissioning is used.

. Manual Commissioning

Manual Commissioning can be used to commission any Flexi EDGE
BTS site.

There are no predefined SCF files required, but it is possible to use
SCF files as a basis to reduce the number of parameters that needs
to be entered during commissioning.

Because of the number of available options and the technical
knowledge required to set those options, Nokia recommends that
only skilled, experienced commissioning engineers perform Manual
Commissioning.

During Manual Commissioning, the commissioning engineer has the
flexibility to change any of the commissioning parameters before
sending the SCF to the BTS.

For more information on the SCF and EasyWizard template files created
by the BSS engineer or Network planner, see Creating SCF or template
files.
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Steps

1. Install the Nokia Flexi EDGE BTS Manager.

See Installing Nokia Flexi EDGE BTS Manager.

If you need to change IP settings, see Changing IP address settings
for Windows XP.

2. Check the prerequisites for commissioning:

See
. Prerequisites for commissioning Nokia Flexi EDGE BTS
. Preparing to commission the Nokia Flexi EDGE BTS

3. Go to one of the following sections, depending on the
commissioning mode used:
. EasyWizard Template Commissioning
. EasyWizard Complete SCF Commissioning
. Manual Commissioning

4. View the commissioning progress and commissioning result.

See Viewing the commissioning progress and the commissioning
result.

If commissioning fails, see the following troubleshooting instructions:
. Handling alarms
. Checklist for troubleshooting

5. If you want to run manual tests, see Running manual tests.

6. Save the commissioning report, see Commissioning report.

Further information

If you want to change commissioning settings or undo commissioning, see

. Changing the settings of a commissioned BTS

. Undo commissioning
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2 Preparing for commissioning

2.1 Prerequisites for commissioning Nokia Flexi EDGE
BTS

. Before commissioning, the physical installation of the BTS (modules,
cabling, antennas and radios) must be complete.

. Make sure you have a PC with Nokia Flexi EDGE BTS Manager
installed, see Appendix Installing Nokia Flexi EDGE BTS Manager.

. Make sure you have a 10/100 Mbit/s Ethernet cable available for the
connection between the BTS and your PC.0

. You need to have the parameter values available that need to be
entered during commissioning. The parameter values are provided
by the network planning process.

. BSC settings: the BTS site must already be created at the BSC for
commissioning to be successfully completed. For instructions on
how to create a BTS site at the BSC, see Radio Network
Administration in BSC/TCSM Product documentation.

. Transmission network setup: the transmission link(s) between the
BSC and the BTS must already be set up so that there is a
transmission path from the BSC to the BTS for all the Abis channels.

If there are any intermediate transmission hubs between the BSC
and the BTS, the cross connections in the hubs should either be set
up at the E1/T1 link level, or at the n x 64 kbit/s level for all the
channels to the BTS in an E1/T1 link.

With the Flexi transmission interface Flexbus sub-module (FIFA), the
transmission link will be established during commissioning.
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These instructions are based on the assumption that the user knows how
to use basic computer software. At least the following actions are needed:
installing SW and uninstalling SW. Nokia also recommends that the user
has the relevant knowledge of base station systems and equipment.

Note

Screenshots included are representations and should be considered as
examples only. The current release of the Nokia Flexi EDGE BTS
Manager software may differ slightly from the shots depicted.

Visual checks and inspection

Perform the first part of the visual check before powering on the BTS at the
power system.

Check the equipment visually to see that there are no fatal installation
errors, which might lead to equipment damage during the power on.

When all is proven to be OK, perform the 'Power on' check and verify the
LED status. For more information, see Appendix LED statuses.

Check the following items:

. the grounding

. power cabling and supply voltage

. other cables and fibres

. LED status during power up

. TX/RX/antenna connector torque check

. Flexbus cables (used with FIFA)

. LAN cable (used with the E1 transmission card)

2.2 Changing IP address settings with Windows XP

Before you start

Consult your System Administrator or IT Helpdesk for instructions on how
to modify the IP address settings for your PC.
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Changes to your IP address settings may affect your ability to connect to
other networks. It is recommended that you make a note of your settings
before changing them so that they can be restored later if required.

The following instructions show how to modify IP address settings for
Windows XP only and assume that no changes have been made to the
default Windows XP start menu contents. If you have changed the used
menu style as it is in earlier versions of Windows, select Start → Settings
→ Network Connections, and continue to step 3.

Steps

1. Select Start → My Network Places.

Figure 1. Selecting My Network Places
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This will open up a Windows Explorer view with a list of known
network places for your PC. The contents of this view will vary from
PC to PC, but on the left hand side there should be a list of tasks. If
these are not visible, make sure that the 'Folders' button in the
toolbar is not selected.

2. Select Network Tasks → View network connections.

Figure 2. Selecting network connections

This will change the view to show the network connections that are
available on your PC. The number and type of connections available
will vary from PC to PC. It is necessary to identify the connection that
will be used to connect to Nokia Flexi EDGE BTS. The specific name
of this connection will vary from PC to PC, but the connection name
will not contain 'wireless' or 'bluetooth'.
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If you are unsure which connection will be used, consult your
System Administrator or IT Helpdesk.

3. Choose the connection that will be used to connect to Nokia
Flexi EDGE BTS and select Network Tasks → Change settings
of this connection.

Figure 3. Selecting Change settings

This will display the properties page for the connection.

4. Scroll down the list of items, and select Internet Protocol (TCP/
IP). Then select the Properties button.
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Figure 4. Selecting Properties

This will display the Internet Protocol (TCP/IP) Properties page
within which the IP address settings can be changed.

5. Ensure that the 'Use the following IP address' radio button is
selected, and enter the IP Address, Subnet mask and Default
gateway according to the following figure.
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Figure 5. Setting IP address

6. Select OK on the Internet Protocol (TCP/IP) Properties page and
then OK again on the connection Properties Page to effect the
changes to the IP address settings.

2.3 Preparing to commission Nokia Flexi EDGE BTS

Steps

1. Connect the Ethernet cable.
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Nokia Flexi EDGE BTS supports MDI/MDIX, therefore both a
straight-through and a cross-over Ethernet cable can be used.

2. Check and connect E1/T1 or Flexbus cables to the transmission
card.

3. Launch the Nokia Flexi EDGE BTS Manager.

4. Choose the Connection | Connect menu item to connect to the
BTS locally.

The Local Connection dialog box opens. Define the BTS IP
address and BTS port number, and click Connect to establish the
connection.

Figure 6. Local Connection dialog box

If the connection fails, see instructions in the Trouble Management of
Nokia Flexi EDGE BTS document.

5. Update the BTS SW if necessary.

In order to prevent errors in commissioning and reduce the time
required to commission and integrate the BTS into the network, it is
recommended to download the latest BTS SW locally using the BTS
Manager (see the Installing Nokia Flexi EDGE BTS Software
document).
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If the BTS Manager reports a mismatch between the Management
Interface Version of the BTS and the BTS Manager, Nokia strongly
recommends downloading the latest BTS SW using the BTS
Manager.

Figure 7. Management Interface Version Mismatch

6. If you need to commission FIFA and microwave radios, choose
the Transmission - Launch FlexiHub Manager menu item.

The Nokia FlexiHub Manager main window opens.

Follow the instructions described in Establishing transmission link.
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3 Establishing transmission link

3.1 Establishing a connection to the node

3.1.1 Starting Nokia FlexiHub Manager

Before you start

This section assumes that:

. Nokia FlexiHub Manager has been installed on your computer (for
installation instructions, see Installing Nokia FlexiHub Manager from
CD-ROM and Installing Nokia FlexiHub Manager from NOLS in
Installing FIFA Flexbus Transmission Sub-module for Nokia Flexi
EDGE BTS).

. You have read the Release Note, which contains important last
minute information.

Note

Screenshots included in this document are representations and should
be considered as examples only. The current release of the Nokia
FlexiHub Manager software may differ slightly from the shots depicted.

Steps

1. Start the computer and Windows.

2. In the Start menu, select Programs → Nokia → Nokia FlexiHub
Manager.

There may be several versions of Nokia FlexiHub Manager installed.
Select the path to the appropriate version.
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Expected outcome

Nokia FlexiHub Manager is started.

3.1.2 Connecting locally

Before you start

When Nokia FlexiHub Manager is used for local management, the
computer must be connected to the local management port (LMP) of the
Nokia Flexi EDGE BTS System Module (ESMA) through an Ethernet
cable.

The IP address of the PC should be set to 192.168.255.130 and the
Netmask to 255.255.255.128.

Note that in most cases you need administrator rights on the PC to change
these settings. If a personal firewall is installed on the PC, it must be
configured to allow communication between the PC and FIFA (IP address
192.168.255.253).

Steps

1. Connect your computer to the LMP of the BTS System Module
through an Ethernet cable.

2. Start the Nokia FlexiHub Manager program.

3. Select File → Connect.

4. Uncheck Connect to Remote Host.

5. Select Flexi EDGE FIFA as Connection Type.

6. Enter Login Information.

Factory defaults:

User name: PAM; Password: PAM

7. Click Connect.
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Figure 8. Connect to Network Element window

3.1.3 Connecting remotely

Steps

1. Start Nokia FlexiHub Manager.

2. Select File → Connect.

3. Check Connect to Remote Host.

4. Select Q1 as Connection Type.

5. Select an existing GCS Sobriquet from the list or enter a new
one for FIFA.
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The sobriquet is the name of the node in the GCS database, which is
used for getting the connection parameters needed for the remote
connection to the node. The sobriquet must be previously defined in
the GCS database, and each sobriquet must be unique in the
database.

6. Click Connect.

Expected outcome

Nokia FlexiHopper Manager is connected to the network element.

3.1.4 Closing the connection to a node

Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.

Steps

1. If necessary, save the changes you have made.

2. In the Nokia FlexiHub Manager menu, select File→ Disconnect.

Expected outcome

The connection to the node is closed.

3.2 Commissioning FIFA, Nokia FlexiHopper, and
Nokia MetroHopper

3.2.1 Overview of commissioning with the Commissioning Wizard

Summary

The Commissioning Wizard contains several parts. Some parts may not
be visible depending on the equipment structure present in the network
element or the way the Wizard is used. If multiple targets are selected for
commissioning, the wizard will proceed through each part in turn. There is
a brief hint on each page; more information is available by clicking the
Help button on each page.
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The Commissioning Wizard defines the minimum number of settings
required for an operational network element. To access identification
information and other settings, select the appropriate item in the Hardware
view in Nokia FlexiHub Manager.

Steps

1. Start the Commissioning Wizard and select the commissioning
targets.

For instructions, see Starting the Commissioning Wizard.

2. Proceed with the Commissioning Wizard.

If you are commissioning a new site, proceed with Commissioning
the network element and continue with either Commissioning a
single hop for Nokia FlexiHopper or Commissioning a single hop for
Nokia MetroHopper, or Commissioning a protected hop.

If you are converting the site from single mode to protected mode,
proceed with steps 1 and 2 in Commissioning the network element
and continue with Commissioning a protected hop.

3. Complete the commissioning.

Follow the instructions in Completing the Commissioning Wizard.

4. Configure any additional settings.

See Configuring properties and settings in Administering FIFA
Flexbus Transmission Sub-module for Nokia Flexi EDGE BTS.

5. Create the 2M-level cross-connections.

See Adding cross-connections.

6. Verify the commissioning.

Monitor the hop as described in Monitoring the hop.

Expected outcome

FIFA Flexbus Transmission Sub-module for Nokia Flexi EDGE BTS is
commissioned after the above steps are completed.
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Further information

Tip

If you want to adjust the settings on the previous pages, you can go
back by clicking Back.

The Next button is disabled until you have filled in all the mandatory
fields (indicated by a yellow marker).

All settings in the wizard are given default values and you should check
them carefully before clicking Next.

3.2.2 Starting the Commissioning Wizard

Before you start

1. Verify that the BTS power is switched on.

2. Connect the local management port (LMP) cable between the PC
and the indoor unit (for instructions, see Connecting the LMP cable
in Administering FIFA Flexbus Transmission Sub-module for Nokia
Flexi EDGE BTS).

3. Start Nokia FlexiHub Manager by selecting Programs → Nokia →
Nokia FlexiHub Manager in the Start menu.

Steps

1. Set up the connection to the network element.

For instructions, see Connecting the LMP cable in Administering
FIFA Flexbus Transmission Sub-module for Nokia Flexi EDGE BTS.

2. Establish the connection in Nokia FlexiHub Manager.

Click the . button or select File → Connect.

For instructions, see Establishing a connection to the node in
Administering FIFA Flexbus Transmission Sub-module for Nokia
Flexi EDGE BTS.

3. On the Nokia FlexiHub Manager's View Bar, select
Commissioning to start the Commissioning Wizard.
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The Commissioning Wizard is launched.

3.2.3 Commissioning the network element

Purpose

If you are commissioning a new site, you should commission the network
element and either the single hop or the protected hop. Follow the steps in
this section first and proceed then with either Commissioning a single hop
for Nokia FlexiHopper, Commissioning a single hop for Nokia
MetroHopper, or Commissioning a protected hop.

If you are converting the site from single mode to protected mode, follow
steps 1 and 2 below and continue with Commissioning a protected hop.

Before you start

Start the Commissioning Wizard as instructed in Starting the
Commissioning Wizard.

Tip

If you want to adjust the settings on the previous pages, you can go
back by clicking Back.

The Next button is disabled until you have filled all the mandatory fields
(indicated by a yellow marker).

All settings in the wizard are given default values. Check them carefully
before clicking Next.

Steps

1. Select the network element and radio hop(s) to be
commissioned. Click the Configure Hardware button, if it is
available.

If you are commissioning a new site, select the network element and
either the single hop(s) or the protected hop as the commissioning
targets.

Note that Nokia MetroHopper does not support a protected hop. For
Nokia MetroHopper it is only possible to select single hop(s).

DN70130343
Issue 1-0 en draft

# Nokia Siemens Networks 25 (138)

Establishing transmission link



If you are converting the site from single mode to protected mode,
you only need to select the protected hop for commissioning.

Clicking Configure Hardware turns the Flexbus power on and
searches for the necessary hardware for commissioning. You are
shown the progress of hardware scanning.

Figure 9. Selecting commissioning targets, the Units column indicates Nokia
FlexiHopper (Plus) microwave radio connected to FIFA
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Figure 10. Selecting commissioning targets, Nokia MetroHopper radio
connected to FIFA

Expected outcome

Once Nokia FlexiHub Manager finds a unit, its type is shown in the
table.

Unexpected outcome

The units are not found. Check the cable connections and start over.

2. Click Next.

3. In case of Nokia FlexiHopper (Plus), if you are converting an
existing site from single mode to protected mode, proceed
directly to Commissioning a protected hop.

Otherwise: Continue commissioning the network element.
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4. Enter the following site information (all fields marked with
yellow are mandatory), and click Next:
. Equipment name
. Group name
. Site name
. Site location
. Name of the installer
. Installation date
. Installation time
. Notes

Figure 11. Configuring properties of the network element

5. Fill in Q1 management information for remote network
management, and click Next.

Enter the following Q1 management information:
. Q1 port speed
. Q1 address
. Q1 Branching Bridge
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Figure 12. Configuring management settings of the network element

6. Set the real time clock settings, and click Next.

Set the real time clock during commissioning by selecting the Set
Network Element Time from PC Time check box.
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Figure 13. Configuring time settings for the network element

Expected outcome

The network element part of the commissioning wizard has been
completed.

7. Continue with commissioning radio hops or proceed to
completing the wizard.
. If you are commissioning a single hop, proceed with

Commissioning a single hop for Nokia FlexiHopper or
Commissioning a single hop for Nokia MetroHopper.

. If you are commissioning a protected hop, proceed with
Commissioning a protected hop.

. If you want to complete the wizard, proceed with Completing
the Commissioning Wizard.
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3.2.4 Commissioning a single hop for Nokia FlexiHopper

Purpose

If you are commissioning a new site, you should commission the network
element and either the single hop or the protected hop. Follow the steps in
Commissioning the network element first and proceed then with either the
steps below or with Commissioning a protected hop.

Before you start

Follow the instructions given in Starting the Commissioning Wizard and
Commissioning the network element.

Steps

1. Perform the antenna fine alignment.

If you are not going to perform the outdoor unit antenna fine
alignment now, continue commissioning by clicking Next and skip
Step 2.

2. Configure the outdoor unit settings and click Apply.

If you are aligning the near-end antenna, select Flexbus Capacity,
enter the TX Frequency value and click Apply. The transmitter
power can be off.

If you are aligning the far-end antenna, select Flexbus Capacity,
enter the TX Frequency and Maximum TX Power values, select
the TX Power check box, and click Apply.

3. When the antenna alignment is finished, click Next.

The modifications made will take effect immediately when you click
Apply.

The incoming signal level can be viewed from the Outdoor unit
status box at the bottom of the window.

If you are going to continue working at the other end of the radio hop,
the alignment settings can be made now and the commissioning can
be completed when the other end of the hop is also operating.
Configure the settings and then cancel the wizard if this is the case.
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Figure 14. Aligning the outdoor unit antenna with Nokia FlexiHopper (Plus)

4. Enter the radio interface settings and click Next.

Enter the radio interface settings according to the network plan.

Note that Unit Name, Installer and Notes are mandatory fields.

Select whether the transmitter power should be on.
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Figure 15. Configuring radio interface settings of the Nokia FlexiHopper (Plus)
outdoor unit

Expected outcome

The single hop commissioning part of the Commissioning Wizard
has been completed. Click Next to continue the wizard.

5. If there is a second hop

Then

Repeat the steps above.

Else

Continue with Completing the Commissioning Wizard.
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3.2.5 Commissioning a single hop for Nokia MetroHopper

Purpose

If you are commissioning a new site, you should commission the network
element and the single hop. Follow the steps in Commissioning the
network element first and then proceed with the steps below.

Before you start

Follow the instructions given in Starting the Commissioning Wizard and
Commissioning the network element.

When commissioning Nokia MetroHopper, it is recommended that you
commission the Slave radio before the Master.

Note that Nokia MetroHopper does not support protected configuration.
For Nokia MetroHopper it is only possible to select the single hop.

Steps

1. Perform the antenna fine alignment.

If you are going to perform the outdoor unit antenna fine alignment
using AGC voltage, select the appropriate Antenna Alignment
option and choose Commissioning Mode, then click Next.
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Figure 16. Selecting commissioning mode for Nokia MetroHopper

2. If aligning the antenna using AGC voltage

Then

Select the required channel spacing and channel number.
Choose whether aligning the near-end or far-end antenna. Click
Start Alignment.

3. When the antenna alignment is finished, click Next.

The modifications made will take effect immediately when you click
Start Alignment.

The incoming signal level can be viewed from the Outdoor unit
status box at the bottom of the window.
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If you are going to continue working at the other end of the radio hop,
the alignment settings can be made now and the commissioning can
be completed when the other end of the hop is also operating.
Configure the settings and then cancel the wizard if this is the case.

4. Enter the radio interface settings and click Next.

Enter the radio interface settings according to the network plan.

Note that Unit Name, Installer and Notes are mandatory fields.

When commissioning a new hop, the same temporary hop ID must
be entered in the Hop ID field at both ends of the hop. This will be
replaced with a permanent hop ID once the commissioning has been
completed.

In manual commissioning, select the channel to be used.
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Figure 17. Configuring radio interface settings of the Nokia MetroHopper
outdoor unit manually

In autosearch commissioning, select the channels that may be used.
The MetroHopper units will choose one of the channels from the list
automatically.
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Figure 18. Configuring radio interface settings of the Nokia MetroHopper
outdoor unit automatically

Expected outcome

The single hop commissioning part of the Commissioning Wizard
has been completed. Click Next to continue the wizard.

5. If there is a second hop

Then

Repeat the steps above.
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Else

Continue with Completing the Commissioning Wizard.

3.2.6 Coarse aligning an integrated 20, 30 or 60 cm antenna

Purpose

The antenna can be coarse aligned (pre-aligned) before the installation of
the outdoor unit. Horizontal adjustment is carried out by turning the
alignment unit around the pole.

Note that coarse alignment is done only when fine alignment is not
sufficient.

The following instructions are for alignment unit which can be used with
integrated 20, 30 or 60 cm antennathe parabolic antenna.

Steps

1. Loosen the vertical adjustment nuts (V) to set the vertical
adjustment to +25° or -25°.

At the factory, the vertical adjustment on the integrated alignment
unit is set to the middle position.

2. Take off the coarse vertical adjustment bolt (V adj. bolt).

3. Turn the mounting plate +25° or -25° and reinstall the bolt.

See figure Locking nuts of the alignment unit.

4. When the antenna is not installed, aim the far-end along the
side surface of the main support.

3.2.7 Fine aligning an integrated 20, 30 or 60cm antenna

Before you start

Fine aligning is done after commissioning Nokia FlexiHopper (Plus)

Align the antenna after the transmit frequency, transmit power, and
capacity have been set according to the plan. The outdoor unit at the other
end of the hop must be pre-aligned to this station and must be sending a
signal on the correct frequency.
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The antenna is aligned on the basis of the monitoring voltage (AGC). The
best signal is achieved using the minimum value of AGC.

Summary

The fine horizontal adjustment range is ±15°. The fine vertical adjustment
ranges are +45° to 0°, ±25°, or 0° to −45°, depending on the coarse
vertical adjustment.

Figure 19. Locking nuts of the alignment unit

The following instructions are for fine aligning an antenna mounted on the
integrated alignment unit.

Steps

1. Connect the DC voltage meter to the monitoring connector
(AGC) through an adapter or a cable with a BNC connector
(male).

2. Turn the vertical and horizontal adjustment screws (13 mm) with
a box or fork spanner.

See Installing and mounting an integrated alignment unit.See
Installing and mounting an integrated alignment unit. One full turn
equals 0.5°.

3. Find the minimum value for the monitoring voltage by vertical
and horizontal adjustment of the adjustment screws.

Spring washer

M8 x 20
(vertical locking screw)

Washer

Horizontal locking
screws

Vertical adjustment

Horizontal
adjustmentWasher

Spring washer M8x20
(vertical locking screw)

Mast bolts (closed)

Twin bolts

Counter partMain support part1 2
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4. When the right alignment has been found, lock the moving
parts together and lock the adjustment screws.

See the figure above. The torque is 20 Nm.

5. Check the monitoring meter.

Alignment should not move during locking.

6. Remove the DC voltage meter and the adapter.

3.2.8 Commissioning a protected hop

Purpose

If you are commissioning a new site, you should commission the network
element and either the single hop or the protected hop. Follow the steps in
Commissioning the network element first and proceed then with either the
steps below or with Commissioning a single hop for Nokia FlexiHopper.

If you are converting the site from single mode to protected mode, you
must follow steps 1 and 2 in Commissioning the network element and then
proceed with the steps below.

Note that Nokia MetroHopper does not support protected configuration.

FIFA supports four types of protected configurations with Nokia
FlexiHopper (Plus): Hot stand-by (HSB), hot stand-by with space diversity,
frequency diversity, and polarisation diversity.

Note that when commissioning hot stand-by (HSB) or hot stand-by with
space diversity, all radio settings except TX Power will be common to both
outdoor units. With frequency diversity protection, however, the TX
frequency must be set differently in each outdoor unit. With polarisation
diversity protection, the scrambling polynomial must be different in each
outdoor unit.

Before you start

Follow the instructions given in Starting the Commissioning Wizard and
Commissioning the network element.
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Steps

1. If you are not going to perform the outdoor unit antenna fine
alignment now

Then

Continue commissioning by clicking Next.

Else

Configure the first outdoor unit settings and click Apply.

If you are aligning the near-end antenna, select Flexbus Capacity,
enter the TX Frequency value and click Apply. The transmitter
power can be off.

If you are aligning the far-end antenna, select Flexbus Capacity,
enter the TX Frequency and Maximum TX Power values, then
select the TX Power check box and click Apply.

The modifications made will take effect immediately when you click
Apply.

The incoming signal level can be viewed from the Outdoor unit
status box at the bottom of the window.

If you are going to continue working at the other end of the radio hop,
you can make the alignment settings now, and you can complete
commissioning when the other end of the hop is also in operation. If
this is the case, configure the settings and then cancel the wizard.
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Figure 20. Aligning the first outdoor unit antenna

2. Click Next.

3. Configure the second outdoor unit settings and click Apply.

Repeat the same procedure as you did for the first outdoor unit.
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Figure 21. Aligning the second outdoor unit antenna

4. Click Next.

5. Enter the radio interface settings for both outdoor units and
click Next.
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Enter the radio interface settings according to the network plan.

Note that Unit Name, Installer and Notes are mandatory fields.

Select whether the transmitter power should be on.

Figure 22. Example of a hot standby radio interface settings
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Expected outcome

The protected hop commissioning part of the Commissioning Wizard
has been completed.

3.2.9 Completing the Commissioning Wizard

Purpose

Once you have completed the tasks instructed in Commissioning the
network element and either Commissioning a single hop for Nokia
FlexiHopper, Commissioning a single hop for Nokia MetroHopper, or
Commissioning a protected hop, follow the steps below to complete the
Commissioning Wizard.

Steps

1. Send the configuration to the node.

In the Send Parameters page, check that the settings are correct
and click Send Parameters to send the settings to the node, then
click Next.

After you have entered all the required settings, a summary of
commissioning settings is displayed. It contains all the settings you
have defined for the radio(s).

Verify the values before sending them to the node. If they are not
correct, go back in the Wizard using the Back button and correct the
settings.

You can use the two buttons above the list to expand and collapse all
items in the list. You can also use the small arrows in title rows to
expand and collapse individual parts of the list.
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Figure 23. Sending Parameters

2. Check the Hop Status, then click Next to continue.

The page is only shown if you have commissioned a complete radio
hop, not just the network element.
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Figure 24. Checking Hop Status

3. Save the final commissioning report to the local drive by
clicking Save to file, then click Finish.

You are shown the final commissioning report.
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Figure 25. Saving the Commissioning Report

The commissioning report cannot be viewed later unless it has been
saved.

Expected outcome

The commissioning report is saved and the Commissioning Wizard
is completed.
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4 Commissioning Flexi EDGE BTS

4.1 EasyWizard Template Commissioning

Purpose

Follow these instructions if you are commissioning Nokia Flexi EDGE BTS
using predefined EasyWizard hardware and transmission template files.

You need to fill in the fields shown in yellow, otherwise the site cannot be
commissioned.

For explanations on what the icons on the navigation tree mean, see Nokia
Flexi EDGE BTS Manager Online Help.

Note

UltraSite EasyWizard files are not compatible with the Flexi EDGE
EasyWizard files.

Before you start

You need to have the parameter values available that need to be entered
during commissioning. The parameter values are provided by the network
planning process.

Steps

1. Select the Commissioning → Wizard menu item or click the
Commissioning button on the View Bar.

The Commissioning task selection page opens.

2. Select the Commission from EasyWizard template file option.
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Figure 26. Commissioning task selection page

3. Select the Hardware file.

Browse for the hardware template file by selecting the Browse
option.

4. Select the Transmission file.

Browse for the transmission template file by selecting the Browse
option.

When the file is opened, all the fields in the wizard pages will be filled
in automatically according to the parameters in the file.

5. Click Next to continue.
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6. Enter the site-specific parameters.
. Site details:

. BCF ID

. Site name

. Site location

. Climate control profile

. Installation details (who and when)

. Notes
. Antenna settings (may also be part of the template)
. Battery backup settings (may also be part of the template)
. Passive unit information

7. Click Next to continue.

The Site Commissioning File (SCF) preview opens.

8. Click Send SCF.

Further information

Next, go to section Viewing the commissioning progress and the
commissioning result.

4.2 EasyWizard Complete SCF Commissioning

Purpose

Follow these instructions if you are commissioning Nokia Flexi EDGE BTS
with a complete Site Commissioning File (SCF).

For explanations on what the icons on the navigation tree mean, see Nokia
Flexi EDGE BTS Manager Online Help.

Before you start

You need to have the specific SCF for that site available. The SCF is
provided by the network planning process.

Steps

1. Select the Commissioning → Wizard menu item or click the
Commissioning button on the View Bar.

DN70130343
Issue 1-0 en draft

# Nokia Siemens Networks 53 (138)

Commissioning Flexi EDGE BTS



The Commissioning task selection page opens.

2. Select the Commission from SCF option.

Figure 27. Commissioning task selection page

3. Select the SCF file.

Browse for the SCF file by selecting the Browse option.

All of the commissioning parameters are loaded from the SCF. There
are no changes that you can make before sending it to the BTS.

4. Click Next to continue.

The Site Commissioning File (SCF) preview opens.
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5. Click Send SCF.

Further information

Next, go to section Viewing the commissioning progress and the
commissioning result.

4.3 Manual Commissioning

Purpose

Follow these instructions if you are commissioning Nokia Flexi EDGE BTS
manually.

You need to fill in the fields shown in yellow, otherwise the site cannot be
commissioned.

To get more information on any of the commissioning pages, you can
select the Help icon on that page.

For explanations on what the icons on the navigation tree mean, see Nokia
Flexi EDGE BTS Manager Online Help.

Before you start

You need to have the parameter values available that need to be entered
during commissioning. The parameter values are provided by the network
planning process.

Note

At the moment the Commissioning wizard supports English alphabet
only.

Steps

1. Select the Commissioning → Wizard menu item or click the
Commissioning button on the View Bar.

The Commissioning task selection page opens.

2. Select the Commission manually option.
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Figure 28. Commissioning task selection

3. Click Next to continue.

The Site Specific Information page opens.

4. Enter the site-specific parameters.
. BCF ID
. Site name
. Site location
. Climate control profile
. Installation details (who and when)
. Notes
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Figure 29. Site Specific Information

5. Click Next to continue.

The Hardware Configuration page opens.

6. Select one of the following options: Specify manually or Specify
from file.
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. To specify hardware configuration settings based on an
existing SCF, select Specify from file, then select Browse.

. To specify hardware configuration settings based on a
configuration predefined by Nokia, select Specify from file,
and click the folder icon.

This will show the configuration picker from which you can
select the configuration you want. You can filter the
configurations shown according to the number of sectors, the
carriers per sector and/or the combining method.

Figure 30. Hardware configuration settings
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Figure 31. Hardware configuration settings - specify from a predefined
configuration

. To specify hardware configuration from the start, select
Specify manually.

7. Click Next to continue.

The Cabling Configuration page with tabs opens.

8. Enter the cabling configuration parameters.

The cabling screen displays the current cabling configuration. You
can modify the values specified on each tab to meet your
requirements:
. Antenna Cabling: provide antenna cabling information for

each antenna.

In the Antenna Settings page (step 10) you can configure
only those antennas that have cables specified in the Antenna
Cabling table.
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Figure 32. Cabling configuration - Antenna Cabling
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. Receiver Cabling: information for providing connections
between receivers

Figure 33. Cabling configuration - Receiver Cabling

. Manual RF Cabling: You need to select Specify cabling
manually to enter RF cabling information. Selecting manual
cabling turns off automatic cabling detection, and you must
then specify all RF cables. If wrong RF cabling is defined
manually, configuration might not work or alarm handling could
work incorrectly as BTS O&M does not check RF-cabling
when manually defined. If the HW Configuration supports
automatic RF cabling detection, it is not necessary to manually
specify the cables. For detailed information on the
configurations, see RF auto-detection supported
configurations.
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Figure 34. Cabling configuration - RF Cabling

9. Click Next to continue.

The Antenna Settings page opens.
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Figure 35. Antenna settings

10. Enter the antenna setting parameters.

You need to enter the antenna settings for each antenna present in
the configuration. Select each antenna on the antenna graphic in
turn, and enter the settings for that antenna until all antennas are
configured.

MHA settings are disabled unless an MHA type is selected (see the
figure below).
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Figure 36. Antenna settings - MHA type not selected

Low Gain MHA settings are disabled unless a Low Gain MHA type is
selected (see the figure below).
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Figure 37. Antenna settings - Low Gain MHA

11. Click Next to continue.

The Battery Backup Unit page opens.
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Figure 38. Battery backup unit

12. Enter the battery backup unit parameters.

13. Click Next to continue.

The Other Passive Units page opens.
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Figure 39. Other passive units

14. Enter the passive unit parameters.

You can provide information for the existing passive units in the list:
. FSEA Flexi System External Alarm
. EWxA EDGE Wideband Combiner
. FCIA Flexi Indoor Cabinet
. FCOA Flexi Outdoor Cabinet
. Other Cabinet
. FCFA Flexi Cabinet Air Filter
. FCDA Flexi Cabinet Smoke Detector
. FCSA Flexi Cabinet Site Support
. FPMA Flexi Power Module
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. FPAA Flexi Power AC/DC sub-module

. FPBA Flexi Power Battery sub-module

. FPDA Flexi Power DC/DC Module

. EMTA 2HU Case

. EMHA 3HU Case

. FMCB 2HU Cover

. FMFA Flexi Mounting Kit

. WMPB Pole Mounting Kit

You can also add more passive units to the list by typing the name of
the unit the Unit Name box. You can specify information for a
maximum of 20 passive units.

15. Click Next to continue.

The Transmission Parameters page opens.
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Figure 40. Transmission parameters

16. Select either the Create new configuration or the Open an
existing configuration option, depending on which files are
available.
. If an existing configuration is available, select the Open an

existing configuration option.
. With the Create new configuration option you can create a

new configuration for a transmission PIU type used. The
following PIUs are supported: Flexi transmission interface E1
asymmetrical sub-module (FIEA), Flexi transmission interface
E1/T1 symmetrical sub-module (FIPA), and Flexi transmission
interface Flexbus sub-module (FIFA).
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Caution

New transmission plug-in units (PIU) may be damaged if the plug-in
units are replaced when the base transceiver station (BTS) power is
switched on. Switch off the Nokia Flexi EDGE BTS before replacing the
transmission PIUs.

Note

In case the transmission plug-in unit (PIU) module type changes,
recommission the Nokia Flexi EDGE BTS to configure it to use the new
transmission PIU module type.

17. Click Next to continue.

The Line Interface (LIF) Settings page opens.

18. Enter the line interface parameters.

You can configure line interface settings for the interface used.

a. Select an interface from the list displayed in the Transmission
equipment view on the left pane. For FIPA, select also the
mode (E1 or T1).

b. Specify if the interface is in use and its name.

The subsequent fields displayed depend on the interface mode.
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Figure 41. LIF settings - FIEA E1 interface
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Figure 42. LIF settings - FIPA T1 interface
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Figure 43. LIF settings - FIFA Flexbus

19. Click Next to continue.

The Synchronization view with two tabs opens.

20. Enter the synchronization parameters.
. On the Active Sources tab, you can

. configure the clock Priority List from a list of available
clock sources.

. add or remove sources from the Priority List

. increase or decrease the priority of a source in the list
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Figure 44. Synchronization - Active sources

. On the Synch Protection tab, you can define the
synchronization protection.

Nokia PDH Loop Protection is a function that provides instant
recovery from transmission failures in a network of network
elements, where each element is assigned two independent
transmission routes. In the case of a fault in one route, traffic,
synchronisation and Q1 management functions are switched
by the system automatically to the intact route.
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Figure 45. Synchronization - Synch Protection

21. Click Next to continue.

The Traffic Allocation view opens.
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Figure 46. Traffic allocation

22. Enter the traffic allocation parameters.

The traffic frame displayed is based on the selected interface.

You can select
. the signal type: TRXSIG, TCH, OMUSIG and EDAP
. the size:16 kbps to 128 kbps

For TCH, the only option is 128 kbps.
. the TRX number for which the signal is meant.

For EDAP, you can select more than one TRX by holding the
Control (Ctrl) key while left-clicking with the mouse on the TRX
names.
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To add a signal to the allocation, click any cell on the table. The cells
will be coloured corresponding to the signal selection and
granularity.

TRXSIG and OMUSIG can be set on TCH. Configurations have to
match with BSC's.

23. Click Next to continue.

The Abis Protection view opens.

24. Define the Abis protection.

If you want to use protection, select Loop and define the parameters
and condition bits. Otherwise select Chain.

Figure 47. Abis Protection
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You need to set the condition bits for each protected interface. Set
the condition bits by selecting the Condition button.

To add condition bits, first select the condition type, the interface
number for the first condition and then its bit from the table on the
right hand side. If the condition type is Equal, select the interface
number and the corresponding bit in a similar way for the second
condition. Select Create Cross Connection(s) to Set Condition
Bits if needed.

Figure 48. Abis Protection - Add Condition Bits

The Condition defines which bits of the loop protected routes should
be checked to determine whether an interface is faulty. There are
two types of condition: A Priority condition type can be used if one of
the two routes is considered "better" than the other, as the BTS will
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switch back to the priority route after the faulty condition in the
priority route is removed. An Equal condition type can be used when
the two routes are of equal quality; no change-over to the previous
route is performed unless the current route fails.

25. Click Next to continue.

The Cross Connections view opens.

26. Enter the Cross Connection parameters.

a. Add cross connections by selecting the Add button.
Alternatively, you can load cross connections from an existing
*.xcs file via the Import option.

Each cross connection requires a label, a type, a granularity
and, in the case of n x 64k, the value of n.

b. To add a cross connection, click within the Tx1/Rx1 box to
select it, and select the interface number.

c. Select the timeslots on that interface by clicking on the
allocations view on the right hand side. The number of
timeslots selected is in accordance with the granularity
settings.

d. Click within the Tx1/Rx1 box to complete the cross
connection. Select its interface number and timeslots in the
same way as for Tx1/Rx1. If protection is required, a similar
process is used for the Protecting Tx/Rx box.

The following Cross Connection types are supported:

Type B (Basic) Bidirectional (B2) through connection

Independent of the type of data (bit
transparency)

Granularities supported: 8k, 16k, 32k,
64k, and n x 64k

Type M (Connecting and Masking) Bidirectional (M2) with granularities of
16k, 32k, and 64k-modifies masked bits
by a logical AND function

Type D (Fixed Bit Pattern) Unidirectional (D1) with granularities of
8k, 16k, 32k, and 64k which transmits a
set pattern
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Type PB (Protected Condition Switch) Bidirectional (PB2) conditional connection

Used in configuring channel protection

Granularities supported: 16k, 32k, 64k,
and n x 64k

Requires a condition, available in two
switchover modes (types): priority and
equal

Figure 49. Cross Connections
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Figure 50. New Cross Connection

27. Click Next to continue.

The Q1 Management view opens.
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Figure 51. Q1 management

28. Define the Q1 management parameters.

Click Add, select the sampling rate (will be the same for all Q1 EOC
allocations), and define the other settings in the table to meet your
requirements. If you enable the Q1 loop protection, select the Loop
option (primary and secondary) in the table.

Note

For a proper working of Q1 BSC polling over Timeslot 0, the BTS have
to be commissioned with the TCH or Cross Connected traffic.
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29. If you use the FIFA and you have not commissioned the radio
part of the FIFA yet, launch FlexiHub Manager.

Figure 52. Launch FlexiHub Manager

For more information, see Establishing transmission link.

30. Click Next to continue.

The Site Commissioning File (SCF) view with two tabs opens.

31. Check the details on the SCF preview page.

DN70130343
Issue 1-0 en draft

# Nokia Siemens Networks 83 (138)

Commissioning Flexi EDGE BTS



. On the Summary tab, you can view the SCF summary in a
tree view.

Figure 53. SCF preview - Summary

. On the Detail tab, you can view a complete SCF in XML
format.
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Figure 54. SCF preview - Detail

If the details are correct, click Send SCF to begin the
commissioning. If the details are incorrect, you can use the Back
button to browse back. If there is information entered incorrectly, the
Send SCF button is not enabled and the errors are indicated by a
red dot in the navigation tree.

32. Click Send SCF.

Expected outcome

The commissioning process begins.
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Further information

Next, go to section Viewing the commissioning progress and the
commissioning result.

4.4 Viewing the commissioning progress and the
commissioning result

Purpose

Sending the SCF to the BTS begins the process of commissioning the
BTS site.

Steps

1. View the commissioning events on the Events tab.

The commissioning progress lights indicate when each step has
started and when it completes.
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Figure 55. Commissioning progress, start
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Figure 56. Commissioning progress, ongoing

2. View the commissioning result.

Expected outcome

When you have successfully completed the commissioning and the
commissioning report is received from the BTS, the tab view is
automatically switched to the Reports tab.
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Figure 57. Commissioning result - Report

The automatic commissioning test results are stored in the
commissioning report. Automatic commissioning tests include:
. Abis loop tests
. TRX loop tests
. EAC input tests

This test is triggered once the BTS reaches supervisory state
and runs for two hours during which time any changes in the
state of the EAC inputs is recorded to the commissioning
report.

In addition, alarms are monitored for 60 seconds after the
supervisory state is reached, and any alarms active during that
time are also recorded to the commissioning report.
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Unexpected outcome

If the commissioning was unsuccessful, you can run manual tests,
see Running manual tests. See also Checklist for troubleshooting.

3. To exit the Commissioning Wizard, click Finish.

4.5 Running manual tests

Purpose

On the Commissioning progress page, you can run manual tests once
the commissioning report is received from the BTS. The results of the
manual tests will not be stored in the commissioning report.

Running the tests after commissioning is optional.

For more information on the types of tests that you can run, see Nokia
Flexi EDGE BTS Manager Online Help.

Before you start

The Manual Tests button becomes enabled when the commissioning
process is completed and the commissioning report displayed.

Steps

1. Click Manual Tests on the Commissioning progress page.

The Test page opens with tabs representing the following testing
options:
. TRX Test
. Cross Connection Validity Check
. EAC Input

Note that starting the manual EAC input test will stop any
ongoing automatic EAC input test (see section Viewing the
commissioning progress and the commissioning result for
more information), and EAC input states will no longer be
recorded in the commissioning report.

. EAC Output
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Figure 58. Manual tests

2. Select the test you want to run by clicking the appropriate tab.

3. To run the test, click Start.

When the test is started, the Test Results list shows the list of tests
to be executed. The results are updated dynamically when the
results are received from the BTS O&M.

If you want to stop the test, click Stop.

If you want to return to the Commissioning progress page, click
Back.

4. After you have run the desired tests, click Finish.
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4.6 Commissioning report

At the end of commissioning Nokia Flexi EDGE BTS, you can save the
commissioning report in a file on the laptop PC hard disk. The report
contains:

. the parameters supplied in the commissioning process,

. test results of the executed tests and

. a list of active alarms.

The commissioning report shows if commissioning is successfully
completed. When commissioning is successfully completed, site
installation and integration work can be completed.

The report is a .txt file that you can open and check with any word
processor. In Nokia Flexi EDGE BTS, the commissioning report can be
updated with changes in the site configuration when Nokia Flexi EDGE
BTS Manager is disconnected. You can upload the report from a BTS at
any time by selecting Fetch from BTS from the Commissioning →
Report menu item.

Note that there is a limit to the size of commissioning report that can be
stored in the BTS (262144 bytes). After this limit is reached, even though
the commissioning procedure continues as usual, the report stops getting
updated. This situation is indicated by the warning "Commissioning Report
Size Exceeds Limit" in the "Executive Summary" part of the
commissioning report, just before the "Details" section.
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5 Troubleshooting

5.1 Handling alarms

Purpose

If there are any alarms during or after the commissioning, you can see
them in the window on the bottom part of the screen. The alarms that are
shown depend on the filters that you can apply in the alarm window.

For more information on the alarms, see Trouble Management of Nokia
Flexi EDGE BTS.

Steps

1. Select an alarm from the displayed list near the bottom of the
screen.

See the figure below.
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Figure 59. Alarms

2. Select the alarm in the Alarms window.

More information on the alarm is available in the Alarms Details
window.

5.2 Checklist for commissioning troubleshooting

If there is a failure in any part of the commissioning procedure, an alarm
appears in the alarm window. You can check the cause of the failure in the
commissioning report.

The commissioning procedure may fail, for example, when:
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. there is no connection to the BTS - check that the BTS is powered
up - the LED on a power supply unit is a good indicator

. the fetch SCF procedure fails

. saving the SCF fails

. sending the SCF during commissioning fails

. the BCF ID is changed during re-commissioning

. the SCF file has illegal data, for example, an unsupported PIU type.

If commissioning fails, check that the BTS cabling is correct and there are
no unexpected unit alarms. Once corrected, try commissioning again with
the Commissioning Wizard.

For more information on commissioning troubleshooting, see Trouble
Management of Nokia Flexi EDGE BTS.

If commissioning is still unsuccessful, contact the BSS Engineer for
assistance.
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6 Changing the settings of a
commissioned BTS

Purpose

You can change the configuration of an already commissioned Nokia Flexi
EDGE BTS using Nokia Flexi EDGE BTS Manager Commissioning
Wizard. This option can be used when a new configuration can solve
problems or when a new configuration can release HW resources for
another site and/or make an element to function more efficiently.

You can also modify the settings of an already commissioned BTS
remotely. To set up a remote connection, you need access to Nokia NetAct
and have the following information available:

. Hostname or IP address of the NetAct server

. Username and password for accessing the NetAct server

. ID (also known as C-Number) of the BSC to which the BTS is
connected

. BCF ID of the BTS

Alternatively, you can use an existing connection via the Nokia Connection
Tool.

Before you start

Nokia recommends that you change settings only for a Nokia Flexi EDGE
BTS site that is already fully successfully commissioned.

Steps

1. Select one of the following options, depending on the mode
used.
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. Change settings from EasyWizard template file

. Change settings from SCF, if you want to use an EasyWizard
complete SCF

. Change settings manually

Figure 60. Changing commissioning settings

These modes are similar to those described for an uncommissioned
BTS (see EasyWizard Template Commissioning, EasyWizard
Complete SCF Commissioning and Manual Commissioning).

If you change the settings manually, the Commissioning Wizard
screens are pre-populated with the existing settings in the BTS,
which you can then change as required.
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When the Commissioning Wizard is launched and Nokia Flexi
EDGE BTS Manager is connected to a commissioned BTS, the
current SCF on that BTS is automatically uploaded and stored in the
location stated on the commissioning task selection screen. This
uploaded SCF can be useful for recovery actions if changing the
settings fails.

Note that when changing settings, the commissioning result
indicates whether the change was successful or not, not that any
existing commissioning errors have been fixed.
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7 Undo commissioning
Purpose

Undo commissioning is not needed during normal operation. Perform undo
commissioning only when instructed during troubleshooting.

Steps

1. Select Undo commissioning of BTS in the Commissioning
Wizard.
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Figure 61. Undo commissioning

2. If you want remove traffic bypass capacity, select Also remove
traffic bypass capacity.

If the bypass capacity is not removed, undoing the BTS
commissioning will leave the BTS in a non-operational state but
other sites that are using this site as a transmission hub should not
be affected.

If the bypass capacity is removed, all transmission cross-
connections will be removed and traffic to downstream sites will be
affected.

102 (138) # Nokia Siemens Networks DN70130343
Issue 1-0 en draft

Nokia Flexi EDGE BTS Commissioning



Expected outcome

Undo commissioning process starts.

Figure 62. Undo commissioning
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Appendix A Installing Nokia Flexi EDGE BTS Manager

A.1 Installing Nokia Flexi EDGE BTS Manager

Purpose

Follow these instructions to install Nokia SiteWizard including the Nokia
Flexi EDGE BTS Manager software on your PC.

Before you start

You should be familiar with installing software on your PC and managing
files in it. Administrator rights are required for installing new software on
your PC.

To set up and install Nokia SiteWizard, you need to have an Internet
connection available to download the Nokia SiteWizard installation file
from Nokia Online Services (NOLS). The installation file can also be
delivered on a removable media (CD-ROM, for example).

Check that your computer meets the system requirements (see the table
below).

Table 1. System requirements for Nokia Flexi EDGE BTS Manager

Microsoft® Windows XP Professional . PC with 300 megahertz or higher processor clock speed
recommended

. Intel Pentium/Celeron family, or AMD K6/Athlon/Duron
family, or compatible processor recommended

. 128 megabytes (MB) of RAM or higher recommended

Microsoft® Windows 2000 Professional
Edition

. PC with 300 megahertz or higher processor clock speed
recommended

. Intel Pentium/Celeron family, or AMD K6/Athlon/Duron
family, or compatible processor recommended

. 128 megabytes (MB) of RAM or higher recommended

Microsoft® Windows 2000 Server Edition . 550 MHz for x86-based computers
. 256 MB of RAM

Microsoft® Windows Server 2003 . 550 MHz for x86-based computers
. 256 MB of RAM
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Table 1. System requirements for Nokia Flexi EDGE BTS Manager (cont.)

Common recommendations . Super VGA (1024 x 768) or higher-resolution video adapter
and monitor

. Keyboard and Microsoft® Mouse or compatible pointing
device

. Minimum of approx. 5 MB free disk space for installation,
excluding JRE and GCS

In all cases, the Host computer must be equipped with a 100Mbit/sec
compatible Ethernet device.

Network settings:

For direct connections to the Flexi EDGE Local Management Port (LMP),
the PC running Nokia Flexi EDGE BTS Manager must belong to the same
subnet as that configured at the LMP.

The PC network settings for Nokia Flexi EDGE BTS Manager should be
the following:

. IP address: 192.168.255.130

. Subnet Mask: 255.255.255.128

. Default gateway: 192.168.255.129

The default settings of the BTS are:

. IP address: 192.168.255.131

. TCP Port: 27500

Note

If a personal firewall is installed on the PC, it may request permission
for Nokia Flexi EDGE BTS Manager (Nokia Flexi EDGE BTS Manager.
exe) to access the local network. Permission must be granted,
otherwise it will not be possible to connect to the Nokia Flexi EDGE
BTS.

For further information about the specifc firewall installed on your PC,
contact your System Administrator or IT Helpdesk.
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For instructions on changing the IP settings, see Changing IP address
settings for Windows XP.

Steps

1. Start Microsoft Windows.

2. To install the Nokia SiteWizard from NOLS, proceed as follows:

Download the Nokia SiteWizard installation package from NOLS
(Care - Software Delivery). For more information about NOLS,
contact your Nokia customer support representative.

Extract the installation package that was downloaded from NOLS to
a temporary location in your computer.

Locate the installation package on your PC, using the Windows
Explorer. Double-click on the setup.exe program icon in the window.

Follow the instructions displayed in the Setup program.

The Setup program copies the files, and at the end of the procedure
it notifies you that the setup is complete.

3. To install the Nokia SiteWizard from CD ROM, proceed as
follows:

Insert the Nokia SiteWizard installation CD-ROM into your PC's CD-
ROM drive. The setup program should start automatically within a
few seconds.

If the setup program does not start automatically, double-click the
CD-ROM drive icon in the My Computer window to open the CD-
ROM disk, and then double-click the setup.exe program icon in the
window.

Follow the instructions displayed in the setup program. GCS should
be chosen for installation along with the Node Managers.

The setup program copies the selected files and notifies when the
installation is complete.
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Appendix B Creating commissioning files

B.1 Creating SCF or template files

Purpose

Site Commissioning Files (SCF) or EasyWizard hardware and
transmission templates are required when commissioning Nokia Flexi
EDGE BTS using one of the following commissioning modes:

. EasyWizard Template Commissioning

. Complete SCF Commissioning

It is also possible to use SCF files as basis with the Manual
Commissioning mode.

With SCF file creation, you can see the same Commissioning Wizard
screens as during manual commissioning of a BTS. The difference is that
instead of sending the file to a BTS at the end of the process, it is saved to
disk to be used later.

Depending on the SCF creation mode, different screens are shown.

. EasyWizard hardware template file: with this option, only the
hardware screens are shown. The user of the template will also see
the following pages, meaning that it is possible to modify any of the
values on those pages at the time of commissioning:

1. Site Specific Information

2. Antenna Settings

3. Battery Backup Unit

4. Other Passive Units

. EasyWizard transmission template file: with this option, only the
transmission-related screens are shown. The user of the template
will not see any of the transmission screens, therefore the template
must contain all of the transmission settings required for the site.

. Complete SCF: with this option, all the screens are shown, but the
SCF cannot be saved unless it contains a valid configuration that
would be accepted by a BTS. If the commissioner uses the SCF as a
'Complete SCF', no changes will be possible to the settings in this
file.

It is also possible to use this SCF during manual commissioning. In
this case all the settings can be modified.
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. Partial SCF: with this option, all the screens are shown, and the SCF
file can be saved at any time in any state. This option is normally
used to specify partial configurations to be used later in manual
commissioning. In such a case the commissioner can modify any of
the settings at the time of commissioning.

Before you start

Nokia Flexi EDGE BTS Manager must be operational but not connected to
the BTS.

Steps

1. Select the Commissioning → Wizard menu item or click the
Commissioning button on the View Bar.

The Commissioning task selection page opens.

Figure 63. Commissioning task selection page, when BTS is not connected
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2. Depending on the template you want to create, select one of the
following: Create EasyWizard hardware template file, Create
EasyWizard transmission template file or Create SCF.
. To create a hardware template, select the Create EasyWizard

hardware template file option.

Follow the steps 5 - 14 and 30 in section Manual
Commissioning.

. To create a transmission template, select the Create
EasyWizard transmission template file option.

Follow the steps 15 - 30 in section Manual Commissioning.
. To create a complete SCF, select the Create SCF option.

Follow the steps 3 - 30 in section Manual Commissioning.
. To create a partial SCF, select the Create SCF option.

Follow the steps 3 - 30 in section Manual Commissioning.

3. Check the details in the SCF preview page.

You can view the SCF summary in a tree view on the Summary tab,
or as a complete SCF in XML format on the Detail tab.

If the details are correct, click Save to save the templates or SCF at
the desired location.

If the details are incorrect, use the Back button to browse back.

4. Save the SCF or template file.
. The extension for the hardware template file must be epb.
. The extension for the transmission template file must be ept.
. The extension for the SCF file must be xml.
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Appendix C LED statuses

C.1 LED statuses

STATES
BTSOM
NOT

RUNNING

PLATFORM
STARTUP

AUTO
DETECT

COMMIS
WAIT
FOR
LAPD

BCF_SW
LOADING

BCF
CONFIGURING

BCF
SUPERVISORY

BACKGROUND
SW LOADING

BCF
RESET

OMUSIG
ON

OMUSIG
OFF

OMUSIG
ON

OMUSIG
OFF

OMUSIG
ON

OMUSIG
OFF

OMUSIG
ON

OMUSIG
OFF

BCF HIGHLIGHT SR BY CC CC CC CC CC CC CC CC CC CC CC SR

ALARM:BCF
CRITICAL

SR BY SR SR SR SR SR SR SR SR SR SR SR SR

ALARM:BCF MAJOR SR BY BR BR BR BR BR BR BR BR BR BR BR SR

ALARM:TRS
CRITICAL

SR BY SY SY SY SY SY SY SY SR

ALARM:TRS MAJOR SR BY SY SY SY SY SY SY SY
SAME PRIORITY AS BCF ALARMS

SR

ALARM:TRS MINOR SR BY SY SY SY SY SY SY SY BY BY BY BY SR

LOCAL_MODE SR BY BY BY NA NA NA BY BY SG NA NA BG SR

BCF OBJ LOCK SR BY SY SY SY SY SY SY SY SY NA SY SY SR

BCF OBJ BLOCK SR BY NA NA NA NA NA NA NA SY SY SY SY SR

NORMAL SR BY BY BY BY BG SY BY SY SG SG BG SG SR

BCF HIGHLIGHT
SR
BR
SY
BY
BG
SG

Colour Priority Legend:

CC = Cycling Colors
SR = Stable Red
BR = Blinking Red
SY = Stable Yellow
BY = Blinking Yellow
BG = Blinking Green
SG = Stable Green
NA = Not Applicable
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Appendix D Using Nokia FlexiHub Manager

D.1 Introduction to Nokia FlexiHub Manager

Before you start

Nokia FlexiHub Manager software application is running on your computer
and a connection to the node has been established.

The Hardware View opens automatically whenever you are managing a
network element.

The Hardware View contains a graphical representation of the network
element. The figure displays the number and configuration of indoor units,
plug-in units, outdoor units, and Extended Flexbus connections.The
Hardware View contains a graphical representation of the network
element. The figure displays the configuration of the indoor unit, outdoor
units, and Flexbus connections.

In the Hardware View you can access the settings and identifications of
each unit, and view the status information for the radio hop. This
information is updated periodically.

Steps

1. To display the pop-up menu, click the right mouse button while
the mouse pointer is over a unit.

2. To display the properties and settings, click on the unit or the
radio hop.

Further information

The Alarms View is displayed below the Hardware View, and also the
Details for a selected alarm. In the Alarms View you can display current
alarms or the alarm history, and you can use a filter to select the types of
alarm to be displayed.

You can click on the icons in the View Bar along the left-hand edge to
select other available views and operations. These include:

. Making 2M-level cross-connections

. Configuring DCN for network management

. Performing software upgrades
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. Monitoring node performance

. Commissioning the node

Note that many of the changes or actions that can be performed in Nokia
FlexiHub Manager do not take place until they have been sent to the node.

D.2 Using online help in Nokia FlexiHub Manager

Purpose

Nokia FlexiHub Manager offers an online help that is available at all times.

Before you start

Nokia FlexiHub Manager software application is running on your computer.

Steps

1. To access the help system, use one of the following methods:

a. In the Manager menu, select Help → Help Topics.

b. Select the help symbol in any view of the Manager.

Expected outcome

Nokia FlexiHub Manager online help opens.

D.3 Printing from a Nokia FlexiHub Manager window

Purpose

You can print the information from selected views to a printer. The window
is printed in text format.

Before you start

Nokia FlexiHub Manager software application is running on your computer
and a connection to the node has been established.

Steps

1. In the Nokia FlexiHub Manager menu, select File → Print.

2. Select the desired information to be printed.
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Expected outcome

The information in the Manager window is printed.

D.4 Exporting information to a text file

Before you start

Nokia FlexiHub Manager software application is running on your computer
and a connection to the node has been established.

Steps

1. In the Manager menu, select File → Save As.

2. Save the required information.

Expected outcome

The information is exported to a text file.

114 (138) # Nokia Siemens Networks DN70130343
Issue 1-0 en draft

Nokia Flexi EDGE BTS Commissioning



Appendix E Configuring properties and settings of FIFA

E.1 Configuring properties

Purpose

All FIFA properties and settings are viewed and edited using the
Hardware View in Nokia FlexiHub Manager. Click on a unit in the
Equipment pane in order to select it.

Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.

Steps

1. On the Nokia FlexiHub Manager View Bar, select Hardware.

The Equipment pane is shown.

2. Select the appropriate unit.

Click on the unit. The settings are shown on the configuration pane
on the right.

Click the tabs to switch between pages.

To view or change far-end settings, select Radio Hop Settings.

3. Make sure the Properties tab is selected, detailing the
properties of the selected unit.
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Figure 64. Nokia FlexiHub Manager Hardware View, Properties

Properties are displayed separately for the network element, indoor
unit, and outdoor units.

4. Type in the desired information in the fields, and click Send.

User-defined properties for a network element or a unit can include,
for example, notes on the installation. Some of the information
cannot be altered because it is read directly from the equipment.

Expected outcome

The properties have been configured.
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E.2 Viewing and changing unit settings

Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.

Steps

1. On the Nokia FlexiHub Manager View Bar, select Hardware.

The Equipment pane is shown.

2. Select the appropriate unit.

Click on the unit. The settings are shown on the configuration pane
on the right.

Click the tabs to switch between pages.

3. Select the appropriate tab.

The settings may be divided under several tabs. You may have to
check all of them.

4. Change the settings for the unit, if necessary.

If certain settings are changed (for example, transmit frequency or
Flexbus capacity), also the settings of the terminal at the other end of
the hop have to be changed correspondingly.

5. Change the settings for the unit, if necessary.

6. Click Send to send the changes to the node.

Expected outcome

The unit settings are displayed and, optionally, you have changed some
settings.

E.3 Configuring network element settings

Purpose

Network element settings define the protection settings for FIFA.
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Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.

Steps

1. On the Nokia FlexiHub Manager View Bar, select Hardware.

The Equipment pane is shown.

2. Select the network element.

Click on any area outside of the units. The settings are shown on the
configuration pane on the right.

Click the tabs to switch between pages.

3. Select the Operation tab to change the operation mode settings.
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Figure 65. Network Element settings

In the drop-down lists, select the value to change the protection
mode, protection method, or primary outdoor unit in a protected
setup. You can also select different changeover criteria.

Expected outcome

The network element settings have been configured.

E.4 Configuring indoor unit settings

Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.
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Steps

1. On the Nokia FlexiHub Manager View Bar, select Hardware.

The Equipment pane is shown.

2. To check or change the indoor unit settings, select the unit.

Click on the unit. The settings are shown on the configuration pane
on the right.

Click the tabs to switch between pages.

3. Select the Indoor Unit Settings tab to check or change interface
settings.

Figure 66. Indoor Unit Settings

. Set a Flexbus in use by clicking the check box.

. In the drop-down list, select the Flexbus capacity.

. Set the outdoor unit power on by clicking the check box.
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4. Click Send to send the changes to the node.

Expected outcome

The indoor unit settings have been configured.

E.5 Configuring outdoor unit settings

Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.

Steps

1. On the Nokia FlexiHub Manager View Bar, select Hardware.

The Equipment pane is shown.

2. To check or change the outdoor unit settings, click on the
outdoor unit.

3. Select the Outdoor Unit Settings tab.
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Figure 67. Outdoor Unit Settings

In the settings tab you can modify the transmit frequency, transmit
power, automatic transmit power control (ATPC/ALCQ), modulation,
and interleaving settings for the outdoor unit(s). In a protected setup,
some settings are common for both radios, depending on the
protection method (hot-standby operation (HSB) or diversity
protection).

4. To turn the transmit power on/off, select/clear the Tx Power
check box.
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5. To change the transmit frequency, type in the new value in the
Tx Frequency (kHz) box or click the arrows to adjust the
frequency.

The frequency step is read from the equipment.

6. To change the transmit power, type in the new value in the
Maximum Tx Power (dBm) box or click the arrow to adjust the
power.

The minimum and maximum values for the transmit power are read
from the equipment.

7. To change automatic transmit power control, select the control
mode from the Auto TX Power Control drop-down list.

The possible operating modes for automatic transmit power control
are Off, ATPC, and ALCQ.

For the ATPC or ALCQ to function, you must set a value in the
ALCQ/ATPC Set Point (dB) box. This value can be obtained from
transmission planning.

Further information

For more information on ALCQ, see the relevant technical note in
Maintenance Documentation in NOLS under Transmission and
Backbone → Microwave Radios → Nokia FlexiHopper Plus
Microwave Radio.

8. To change the interleaving mode, select a new value from the
Interleave status drop-down list.

Possible values for interleaver status are Off, Depth 2, and Depth 4
in 4-state modulation mode.

Note that the outdoor unit stops transmitting while this setting is
being changed. Change the setting accordingly also at the other end
of the hop.

In 16-state modulation the interleaver status is fixed to Depth 4.

9. To change the modulation type, select a new value from the
Modulation mode drop-down list.
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Possible values are 4-state modulation or 16-state modulation.
Changing the modulation mode settings interrupts the traffic for one
minute.

Note that 16-state modulation is a licensed feature, and may require
installation of a software licence.

10. In the Outdoor Unit Settings dialogue box, click Send to send
the changes to the node.

Expected outcome

The outdoor unit settings have been configured.

E.6 Configuring Q1 settings

Before you start

Make sure that Nokia FlexiHub Manager is running on your computer and
a connection to the node has been established.

Steps

1. On the Nokia FlexiHub Manager View Bar, select DCN.

The DCN view is shown.

2. Select the Q1 tab.

3. View and change, if necessary, the Q1 port settings.

To change the Q1 address or the baud rate of the Q1 port, type in the
desired value or select it from the list.
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Figure 68. Configuring Q1 settings; BTS Polling Configuration

When FIFA is used with BTS polling, the Q1 port address is fixed to
4087 and the Q1 speed must be set to 9600 bit/s. This is the rate
used by the BTS.

In BSC polling the Q1 address must be configured in the range 0 -
3999 according to the Q1 plan. The Q1 port speed must be set to the
same value defined for the Q1 bus in the BSC.
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Figure 69. Configuring Q1 settings; BSC Polling Configuration

4. View and change, if necessary, the Q1 branching settings.

Select or clear the boxes to achieve the desired setting.

5. Click Send to send the changes to the node.

Expected outcome

The Q1 settings have been set.

Further information

For more information about the Q1 addresses, see Q1 addresses in
Product Description for FIFA Flexbus Transmission Sub-module for Nokia
Flexi EDGE BTS.
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E.7 Configuring IP settings

Before you start

Make sure that Nokia FlexiHub Manager is running on your computer and
a connection to the node has been established.

Steps

1. On the Nokia FlexiHub Manager View Bar, select DCN.

The DCN view is shown.

2. Select the IP tab.

The IP settings are used for local management only, and cannot be
changed. Modifications can only be made to the User Name and
Password controlling user access.

Figure 70. IP Settings
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3. Click Send to send the changes to the node.

Expected outcome

The IP settings have been set.

E.8 Setting the real time clock

Before you start

Nokia FlexiHub Manager is running on your computer and a connection to
the node has been established.

Steps

1. On the Nokia FlexiHub Manager View bar, select DCN.

2. Select the Time tab.

3. Check the Set Local Time in Network Element from PC Time
check box.

4. Click Send to send new real time clock settings to the node.

Expected outcome

The real time clock has been set and the check box is cleared.
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Appendix F Configuring FIFA Cross-Connections

F.1 Creating cross-connections

Use the cross-connections to define how signals are routed between
interfaces and radio hops in the network element.

Figure 71. Cross-Connections View
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Figure 72. Cross-Connections View

You can view, create, manage, and remove 2Mbit/s cross-connections in
the cross-connections view.

Free
.

The channel is not used for a cross-connection.
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Selected
.

You have selected this channel, the cross-
connection with this channel, or the channel to
which this channel is cross-connected.

Selected cross-connection lines are highlighted with the same colour as
the selected channel buttons.

Once you have made changes (such as adding, renaming, or removing a
cross-connection), an approval bar with buttons Send and Cancel
appears below the table. Choosing Send sends the changes to the
network element. Cancel restores the user interface to the initial state
before the editing started. To exit the Cross-Connections View, you have to
choose either Send or Cancel.

F.2 Adding cross-connections

Purpose

You can add cross-connections between two channels, or connection
points, in different interfaces.

Before you start

You are logged in and have adequate user rights to create cross-
connections.

Steps

1. Select Cross-Connections from the View Bar on the left.

The cross-connections view is shown with two tables: one active
table and one inactive table. The active table is shown first.

2. Select the first channel.

Click on the first connection point in one of the interfaces (the order
is of no importance).

3. Select the second channel.

Click on the second connection point in another interface.

Expected outcome
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The cross-connection is drawn on the table.

4. Click Send.

Expected outcome

The cross-connection table update is sent to the node.

Unexpected outcome

If the system fails to send the new settings to the node, you will receive an
error message. Try sending the settings again by clicking Send.

Further information

The cross-connection is named automatically (for example, Flexbus1-3 <-
> Flexbus2-3, where the number after the hyphen is the channel number).
You can rename the cross-connection by clicking Rename CC.

F.3 Removing cross-connections

Purpose

You can remove cross-connections between two channels, or connection
points, in different interfaces.

Before you start

You are logged in and have adequate user rights to remove cross-
connections.

Steps

1. Select Cross-Connections from the View Bar on the left.

Expected outcome

The cross-connections view is shown with two tables: one active
table and one inactive table. The active table is shown first.

2. Select the cross-connection you want to remove.

Click either the cross-connection line or one of the channels.

3. Click Remove CC at the top of the table.
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Expected outcome

The cross-connection is removed from the table.

4. Click Send.

Expected outcome

The cross-connection table update is sent to the node.

Unexpected outcome

If the system fails to send the new settings to the node, you will receive an
error message. Try sending the settings again by clicking Send.

F.4 Activating a cross-connection table

Purpose

There are two cross-connection tables that can be edited, one of them is
active, that is, those settings are used by the node, and one is inactive.
The active table has the word Active on its tab.

Before you start

You are logged in and have adequate user rights to activate cross-
connection tables.

Steps

1. Select Cross-Connections from the View Bar on the left.

Expected outcome

The cross-connections view is shown with two tables: one active
table and one inactive table. The active table is shown first.

2. Select the inactive table by clicking its tab.

3. Click Activate Table at the top of the table.

Expected outcome

The status of the table is changed to Active.

4. Click Send.
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Expected outcome

The activated cross-connection table is sent to the node.

Unexpected outcome

If the system fails to send the new table to the node, you will receive an
error message. Try activating the table again by clicking Send.

F.5 Cloning a cross-connection table

Purpose

There are two cross-connection tables that can be edited. You can clone,
or copy, the contents of one table to the other.

Before you start

. You are logged in and have adequate user rights to clone cross-
connection tables.

. One of the tables is empty or has cross-connections that you can
safely discard.

. You have sent to the node all your changes to the table by clicking
the Send button.

Steps

1. Select Cross-Connections from the View Bar on the left.

Expected outcome

The cross-connections view is shown with two tables: one active
table and one inactive table. The active table is shown first.

2. Select the table you want to clone (copy) by clicking its tab.

3. Click Clone Table at the top of the table.

Expected outcome

The contents of the table are cloned to the other table.

4. Click Send.
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Expected outcome

The cloned cross-connection table is sent to the node.

Unexpected outcome

If the system fails to send the new table to the node, you will receive an
error message. Try activating the table again by clicking Send.

F.6 Configuring additional settings

Purpose

Perform the following tasks after the actual commissioning is completed, if
needed.

Steps

1. Make any additional settings with Nokia FlexiHub Manager.

For instructions, see Configuring properties and settings in
Administering FIFA Flexbus Transmission Sub-module for Nokia
Flexi EGDE BTS.

2. Install any necessary software upgrades.

For instructions, see Upgrading software with Nokia FlexiHub
Manager in Installing FIFA Flexbus Transmission Sub-module for
Nokia Flexi EGDE BTS.

3. Install any required software licences.

Time-limited (60-day) trial licences may be used for commissioning.
However, long-term operation may require installation of non-time-
limited licences for certain indoor and outdoor unit features. Licence
installation can also be performed remotely.

4. Perform manual configuration backup or enable automatic
configuration backup in the indoor and outdoor units (if
desired).

For instructions, see Configuration backup in Product Description for
FIFA Flexbus Transmission Sub-module for Nokia Flexi EDGE BTS.

5. Reset performance data.
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For instructions, see Resetting the counters in Administering FIFA
Flexbus Transmission Sub-module for Nokia Flexi EDGE BTS.

6. Monitor the hop for at least half an hour.

For instructions, see Monitoring the hop.

7. Save the alarm log (if needed).

For instructions, see Exporting information to a text file in
Administering FIFA Flexbus Transmission Sub-module for Nokia
Flexi EDGE BTS.

8. Save the cross-connection information (if needed).

For instructions, see Exporting information to a text file in
Administering FIFA Flexbus Transmission Sub-module for Nokia
Flexi EDGE BTS.

9. Close the connection to the node.

For instructions, see Closing the connection to a node in
Administering FIFA Flexbus Transmission Sub-module for Nokia
Flexi EDGE BTS.

Expected outcome

The commissioning has been completed.
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Appendix G RF auto-detection supported configurations

G.1 RF auto-detection supported configurations

The Flexi EDGE Base Station supports automatic RF cable detection for
the sector configurations listed in the following table. The Flexi EDGE
Base Station supports HW configurations that are a combination of
different sector configurations, as long as each sector configuration is
listed in the table below. The maximum number of sectors supported by
the Flexi EDGE Base Station is six.

Table 2. Sector configurations supporting automatic RF cable detection

Number
of TRX

TX
Combini
ng

RX
diversity

Number
of Dual
TRX
Modul
(EXxA)

Number
of Dual
Duplexer
Module
(ERxA)

Number
of Wide
Band
Combine
r Sub-
Module
(EWxB)

Number
of
Antenna

1 to 2 By-pass 2UD 1 1 0 2

3 By-pass 2UD 2 2 0 3

4 By-pass 2UD 2 2 0 4

1 to 2 2-way 1UD (no
diversity)

1 1 1 1

3 to 4 2-way 2UD 2 1 2 2

3 to 4 4-way 1UD (no
diversity)

2 1 3 1

5 to 8 4-way 2UD 4 1 6 2

In addition, the Flexi EDGE BTS supports automatic RF cable auto-
detection of the cost-optimised base station configurations listed in the
table below.
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HW
Confi
gura
tion

TX
Combi
ning

RX
diversi
ty

Numb
er of
Dual
TRX
Modul
(EXxA)

Numb
er of
Dual
Duple
xer
Modul
e
(ERx
A)

Numb
er of
Wide
Band
Combi
ner
Sub-
Modul
e
(EWx
B)

Numb
er of
Syste
m
Modul
e
(ESM
A)

Numb
er of
Anten
na per
sector

Numb
er of
Anten
na

1+1 By-pass 1UD
(no
diversi
ty)

1 1 0 1 1 2
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